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Je me présente

1 • octobre 5 • février

Danse danse, le lutinMission 
accomplie!

Mission 
accomplie!

Nom : _________________

Scrapbook poétique

2 • novembre 6 • mars

Un récit animéMission 
accomplie!

Mission 
accomplie!

Une carte de souhaits

3 • décembre 7 • avril

Au fil de mes lecturesMission 
accomplie!

Mission 
accomplie!

Une récré digne d'un 
roman photo!

4 • janvier 8 • mai
Les mesures, c'est 

SketchUp!
Mission 

accomplie!
Mission 

accomplie!

An 2
5e année

Mission possible en TIC



SCRAPBOOKING DIGITAL
Avec PowerPoint

1. Insérez le disque dans le lecteur et ouvrez une nouvelle présentation 
(vide) PowerPoint

2. Enregistrez

3. Insérez un arrière-plan
• Format > Arrière-plan...

• Cliquez sur la flèche  et sélectionnez Motifs et textures... 

• Onglet Image > Bouton Sélectionner une image...
• Choisissez l’arrière-plan de votre choix

• Regarder dans : (cliquez sur la flèche et choisissez le disque)
• Choisissez votre thème
• Choisissez un papier (double-cliquez)
• OK
• Appliquer

4. Insérez les éléments décoratifs
• Insertion
• Image > À partir du fichier…
• Choisissez l’image (double-cliquez)
• Jouez avec l’image (redimensionnement, rotation, etc.)
• Répétez ces étapes jusqu’à ce que la page soit à votre goût

5. Insérez des photos ou d’autres images
• Assurez-vous que la barre d’outils image soit accessible
• Clic droit sur l’image pour changer l’ordre
• Lorsque le montage est à votre goût, groupez les éléments (plus facile 

pour le déplacement, surtout lorsque l’on utilise des lettres).  
On peut les dissocier au besoin.

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) • février 2011



6. Pour écrire du texte
• Insertion > Zone de texte
• Écrivez et mettez en forme le texte (police, couleur, grosseur, etc.)
• Placez la zone de texte à l’endroit voulu
• Jouez avec le bloc de texte (rotation, plans, etc.)

Petits extras

1. Pour changer le format des diapositives :
• Fichier > Mise en page...

• Cliquez sur la flèche  et sélectionnez Personnalisé 

• Ex : 30 cm X 30 cm

2. Pour faire une image de votre diapositive :
• Sur la diapositive : Fichier > Enregistrer sous...
• Enregistrer dans : (D ou X)
• Nom de fichier :
• Type de fichier > JPEG ou GIF
• Diapositive en cours uniquement

*** N’oubliez pas d’enregistrer votre travail ***

Amusez-vous!

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) • février 2011



 

Logiciel d’arts plastiques et 
de communautique 

 
Petit guide abrégé 

LopArt 
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Les outils du portfolio 

 

 
 

 

Astuces 

 

 Pour récupérer son dessin en format .lop, cliquez sur la majuscule puis sur la page blanche. 

 Pour démarquer un détail ou une forme, dessiner la ligne contour après le dessin, pour éviter de dépasser lors du 
remplissage.  

 Pour transférer une image d’un portfolio LopArt à un autre, appluyez sur la 
touche majuscule avant d’appuyer sur l’icône d’exportation.  
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Les outils de dessin du canevas 
 

 

 
Les textures 
 

 

 

1 2 3 4

5 6 7 8 

1 2 3 4 

5 6 7 8 

1. Gouache 
2. Aquarelle 
3. Aérosol 
4. Cire 
5. Fusain 
6. Encre 
7. Cire 
8. Pastel 
 

1. Écailles 
2. Taches 
3. Eau 
4. 
Branches/Foin 
5. Cheveux 
6. Feuilles 
7. Frisous 
8  Écorce

1 2 3 4

5 6 7 8

1. Écorce 
2. Étoiles 
3. Pétales/Cercles 
4. Écorce 
5. Guirlande 
6. Feuilles 
7. 
Pelouse/Fourrure 

 
 

Niveau 1 
 

Niveau 2 
 

Niveau 3 
 

Couleurs Duo-tons Textures 

Niveaux de 
textures 
 

Trait

Transparence 

Taille Animation 

Annuler ou 
rétablir 
 

Vitesse 
d’animation 
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Les couleurs et les duo-tons 
 

 

 

 

 Astuce : Pour retrouver une couleur, cliquez sur celle-ci dans le canevas (sur le dessin) en enfonçant la touche 
majuscule. Ainsi, tous les paramètres précédemment établis se réaffichent.  

 

Goutte d’eau pour 
l’estompage 
 

Tons de gris 
 

Couleurs Duo-tons 

Couleur 
sélectionnée 
 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Suzanne Harvey 
Service local du RÉCIT 
Commission scolaire des Chênes 
 
recit.csdc.qc.ca Février 2009 

Ré a lis e r  un pho t oroman
Avec ComicLife  
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Étape 1 : bâtis un Scénario 

 
 
 

Équipe : 
 
 

Titre : 
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Étape 2 – Réalise la bande dessinée 
 

 
 
 

 
 
 

 
 
 

 
 
 
 

D éma r r e  Comic  Li f e  

Choisis  un mod è l e  d e  p a g e . Clique  d e ssus  e t  g liss e - l e  j usque  d ans  l a  p a g e . 
 

Ch e r ch e  t on dossi e r  d e  pho t os.  Ouvr e - l e .
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A j out e  d e s  phy l a c t è r e s,  d e s  e f f e t s  d e  l e t t r a g e  e t  d e s  comme nt a ir e s.

Gliss e  l e s  pho t os  d ans  l e s  p ann e aux.



                      

SCRATCH  
 

Pour bien commencer 
avec 

Version 1.4 

http://scratch.mit.edu 
 



1    Déplace-toi 

 

Déplace le bloc de commande avancer de ... pas 
dans l'aire des scripts. 

 

Clique sur le bloc pour faire avancer le chat de 10 pas. 

http://scratch.mit.edu          SCRATCH 

 



 

2   Ajoute des sons 

Déplace le bloc de commande jouer du tambour ... pour ... temps et 
assemble le au-dessous du bloc de commande avancer de ... pas. 

Clique et écoute. 

Si tu n’entends pas le son, vérifie que les 

paramètres de son de ton ordinateur sont 

corrects. 

. 

Tu peux choisir des sons différents à 
partir du menu déroulant. 

http://scratch.mit.edu          SCRATCH 

 

 

 

 

 

 

Clic 



 

3 Commence par une danse  

Ajoute un autre bloc de commande avancer de ... pas. 
Clique à l'intérieur du bloc et ajoute un signe moins.  

Clique sur n'importe quel bloc pour 
lancer l'exécution de la pile. 

Ajoute un bloc de commande jouer du tambour ... pour ... temps 
ensuite choisis un autre son et clique pour exécuter. 
 

http://scratch.mit.edu          SCRATCH 

 

 

 



4   Encore et encore 

Déplace un bloc de commande répéter indéfiniment et place-le sur le 
dessus de la pile. 
La bouche du bloc de commande répéter indéfiniment entoure les 
autres blocs. 

To drag a stack, pick it up from the top block. Clique pour exécuter. 

Pour arrêter, clique sur le bouton 
stop en haut de l'écran. 

http://scratch.mit.edu          SCRATCH 

 

 

 
 

Tu peux cliquer sur n'importe 
quel bloc pour exécuter la pile . 
 



 

 

5    Le drapeau vert 

Déplace le bloc de commande   
 

  et assemble-le sur le 
dessus de la pile. 

Chaque fois que tu cliques sur 
le drapeau vert, ton script va  
s'exécuter.  
 
 
Pour arrêter, clique sur le 

bouton d'arrêt.  

http://scratch.mit.edu          SCRATCH 

 



 

6    Change les couleurs 
 

Maintenant, essayons quelque chose de différent… 

Déplace un bloc de commande modifier l'effet ... par   

Clique pour voir ce qui se passe. 

http://scratch.mit.edu          SCRATCH 

 

 



Déplace un bloc de commande  
et assemble-le au-dessus du bloc 

Appuie sur la barre espace 
sur ton clavier. 

Tu peux choisir ta touche 
préférée à partir du menu 
déroulant. 

 

7  En appuyant sur une touche 

http://scratch.mit.edu          SCRATCH 

 



BOUTONS NOUVEAU LUTIN: 

Dessine ton propre lutin. 

Choisis un nouveau lutin dans un 
dossier. 

Obtiens un lutin au hasard. 

Pour ajouter ce lutin, clique 

Ensuite va au dossier "people' 
et puis choisis “jodi1”. 

 

8    Ajoute un lutin 

On appelle chaque objet 
dans Scratch un lutin ( en 
anglais Sprite ). 

Pour ajouter un nouveau 
lutin, clique sur l'un de 
ces boutons. 

 
 

http://scratch.mit.edu          SCRATCH 

 

 

 

 



 

9       Découvre ! 

Maintenant tu peux dire au lutin ce qu'il doit faire.  
Essaie les étapes suivantes ou découvre toi-même. 

DIRE QUELQUE CHOSE  

Clique sur le bouton de la catégorie 

Apparence  
et déplace le bloc de commande  

dire ... pendant ... secondes.  

 

Clique à l'intérieur du bloc dire ... et change 

les mots. 

 

Essaie le bloc penser ..., aussi... 

LES EFFETS D'IMAGE 
 

Utilise le menu déroulant pour choisir 
des effets différents. 

Ensuite clique sur le bloc pour voir le 
changement. 

Pour effacer les effets, clique sur le 
bouton Stop. 

http://scratch.mit.edu          SCRATCH 
 

Quoi de neuf? 

 

 

 



 

10   Découvre plus! 
 

AJOUTE UN SON 

Clique sur l'onglet Sons . 

Enregistre ton propre son. 

Ou Importe un fichier  son 

(MP3, AIF, or WAV format).
 

 

Clique sur l'onglet Scripts, et 
utilise le bloc de commande jouer 
le son.  

Choisis ton son à partir du menu 
déroulant. 
 

AJOUTE UNE SIMULATION 

En alternant entre les costumes,  

tu peux alterner les lutins. 

Pour ajouter un nouveau costume, 
clique sur l'onglet Costumes . 

Clique sur Importer pour ajouter un 
deuxième costume.  
(Par exemple, essaie l'image “jodi2” 

du dossier "People".)  

http://scratch.mit.edu          SCRATCH 
 

Clique sur l'onglet Scripts.  
 
Crée un script qui permet de 

passer d'un costume à l'autre. 

 

 

 

  



 

 

http://scratch.mit.edu          SCRATCH 
 

Tu peux créer de nombreux types de projets avec Scratch. 

Pour voir des exemples de 
projets, sélectionne Ouvrir dans 
le menu déroulant Fichier. 
 
Ensuite, clique sur le bouton  
Exemples, et choisis l'un des 
dossiers. 
the folders. 
Tu peux tenter de commencer 
avec une photo de toi-même. 
Ou ton personnage favori. Ou 
commence par animer les 
lettres de ton nom. 

Quand tu as une idée de nouveau projet, 
sélectionne Nouveau dans le menu 
déroulant Fichier et commence à créer. 

★ 
Clique sur Partage pour 
télécharger ton projet sur le site 
web de Scratch : 
http://scratch.mit.edu. 

Visite le site web de Scratch 
pour en apprendre plus! 
 

Idées... 
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6 

Enregistrement à l’aide d’un microphone 

1 Réglez le volume d’enregistrement. 

2 Faites un essai pour vérifier les niveaux. 

Cliquez sur le bouton Enregistrer et captez 
quelques secondes de son. 

Cliquez sur le bouton Arrêt pour stopper 
l’enregistrement. 

Supprimez la piste d’essai. 
Trop fort Trop faible Correct ! 

4 Enregistrez le résultat: Fichier => Enregistrer sous. 
 

ATTENTION: Il y a aura un dossier (_data) de créé ainsi que deux fichiers (.aup et .bak). Si vous voulez déplacer votre 
enregistrement, vous devez déplacer ensemble le dossier ainsi que les deux fichiers. 

3 Enregistrez tout le texte d’un personnage, puis cliquez sur arrêt. Prendre soin de laisser un 
peu de silence AVANT et APRÈS chaque réplique. 
 
Enregistrez autant de pistes qu’il y a de personnages. Nommez chaque piste pour vous  
aider à faire votre montage. 



 

© Karine St-Georges  
Cs des Chênes 2009 

Exporter le montage en format wav ou en format mp3 

11 

1 
Le format wav offre la meilleure qualité sonore mais occupe beaucoup de 
place sur le disque dur. 

Le format mp3 offre une qualité sonore acceptable et divise environ par 10 
l’espace nécessaire sur le disque dur. Le mp3 est le format standard d’Internet. 

Le format Ogg Vorbis est un format libre. Il offre une qualité sonore légère-
ment supérieure au mp3 tout en occupant un peu moins d’espace. Il faut un 
logiciel spécialisé pour lire ces fichiers, mais ce logiciel est gratuit. 

Pour exploiter votre montage dans un autre logiciel, vous devez l’exporter 
dans un format universel. 

Si vous désirez télécharger Audacity, vous pouvez aller à l’adresse suivante: 
http://audacity.sourceforge.net/ 

 
Pour exporter en mp3, vous devez installer un utilitaire nommé  
LAME MP3 ENCODER. Il est possible de télécharger l’utilitaire au même en-
droit que le logiciel 

2 3 
Cliquez sur OK. 

Choisir un emplacement pour le fichier, 
donner un nom au fichier et enregistrer. 
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L'interface de FlipBoom All Star

Ajouter ou 
supprimer une 

page

Sélectionner une 
couleur dans 

l'espace de dessin

Choisir une couleur 
dans le cercle 
chromatique

Bibliothèque 
d'images

Importer une 
image ou une 

photo

Nouveau document

Outils de dessin

Couleur de 
remplissage des 
zones fermées

Tracer des formes 
ou des lignes

Écrire du texte

Importer du son 
(MP3)

Copier la page 
sélectionnée

Ouvrir un 
document existant Enregistrer Annuler Afficher le fantôme

Propriétés des 
outils de dessin

Visionner 
l'animation

Vitesse de 
l'animation



Mission possible en TIC • Julie Aubé et Suzanne Harvey • RÉCIT de la CSDC

Effectuer une mise en page avec Publisher

2. 

1.     Ouvre Publisher

 3. 

Insère le titre
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4.

Insère du texte

5.

6.
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7.

Insère une image clipart



SCRAPBOOKING DIGITAL
Avec PowerPoint

1. Insérez le disque dans le lecteur et ouvrez une nouvelle présentation 
(vide) PowerPoint

2. Enregistrez

3. Insérez un arrière-plan
• Format > Arrière-plan...

• Cliquez sur la flèche  et sélectionnez Motifs et textures... 

• Onglet Image > Bouton Sélectionner une image...
• Choisissez l’arrière-plan de votre choix

• Regarder dans : (cliquez sur la flèche et choisissez le disque)
• Choisissez votre thème
• Choisissez un papier (double-cliquez)
• OK
• Appliquer

4. Insérez les éléments décoratifs
• Insertion
• Image > À partir du fichier…
• Choisissez l’image (double-cliquez)
• Jouez avec l’image (redimensionnement, rotation, etc.)
• Répétez ces étapes jusqu’à ce que la page soit à votre goût

5. Insérez des photos ou d’autres images
• Assurez-vous que la barre d’outils image soit accessible
• Clic droit sur l’image pour changer l’ordre
• Lorsque le montage est à votre goût, groupez les éléments (plus facile 

pour le déplacement, surtout lorsque l’on utilise des lettres).  
On peut les dissocier au besoin.

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) • février 2011



6. Pour écrire du texte
• Insertion > Zone de texte
• Écrivez et mettez en forme le texte (police, couleur, grosseur, etc.)
• Placez la zone de texte à l’endroit voulu
• Jouez avec le bloc de texte (rotation, plans, etc.)

Petits extras

1. Pour changer le format des diapositives :
• Fichier > Mise en page...

• Cliquez sur la flèche  et sélectionnez Personnalisé 

• Ex : 30 cm X 30 cm

2. Pour faire une image de votre diapositive :
• Sur la diapositive : Fichier > Enregistrer sous...
• Enregistrer dans : (D ou X)
• Nom de fichier :
• Type de fichier > JPEG ou GIF
• Diapositive en cours uniquement

*** N’oubliez pas d’enregistrer votre travail ***

Amusez-vous!

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) • février 2011



1. Ouvre SketchUp

Google SketchUp

2. Choisis le Grand jeu d'outils.
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